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1. Introduction

Mac-Barcode is a program that lets vou produce bar code labels
and bar code worksheets on the Apple Macintosh computer. Labels
and worksheets can include bar codes, text, and simple line
drawings that you create with Mac-Barcode, Artwork can be drawn
with MacPaint and added to Mac-Barcode images. When your
labels and worksheets are finished, Mac-Barcode lets you print
them on labels or paper with the Macintosh Imagewriter printer.
You can also store finished labels and worksheets on diskettes and
reprint them in the same form or in a modified form.

How to Use This Book

To start using Mac-Barcode right away, turn to Chapter 3, “Using
Mac-Barcode,” It contains an overview of Mac-Barcode’s

tools and commands. You'll also find a series of step-by-step
instructions to guide you through a sample session in which you
create a bar code. If you want, you can turn to this sample session
right now before reading anything else.

Chapter 2, “About Bar-Codes,” contains general information on bar
codes and bar code symbologies. You'll find guidelines here for
choosing appropriate symbologies for various applications. There
is also a table in this chapter summarizing the features of the
seven symbologies supporied by Mac-Barcode.

Chapters 4 through 10 explain Mac-Barcode’s tools and commands

in detail. To find a specific topic in these chapters, use the table of
contents and index.

HOW TO USE THIS BOOK 5



Appendix A tells where to write for more information on bar
codes, bar code symbologies, and bar code standards used in
specific industries. Appendix B is a table that shows three-digit
character representations used in Code 128 (USD-6).

6 INTRODUCTION
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2. About Bar Codes

Bar codes are a form of printed information that can be read by
machines called scanners. They are widely used because they offer
several advantages over other forms of machine-readable
information. Bar codes can be scanned with a high degree of
accuracy, they can be easily atrached to most objects, and they can
be reproduced by ordinary printing equipment at low cost. Bar
code technology is three million times more reliable than
keyboard data entry and three hundred times more reliable than
optical character recognition (OCR).

A variety of different scanning devices can be used to read bar
codes. The light pen wand, a relatively inexpensive scanning
device, is moved across a bar code label by hand to read the
encoded information. The wand must touch the label in order to
read it. The Automatic Moving Beam Laser Scanner, a more
expensive device, can read bar codes at distances up to 50 inches.

There are many different bar code symbologies, but all of them
embody the same basic concept. Numbers and letters are
represented by a series of lines called bars that are separated by
spaces. The bars and spaces are of various widths, Unique
combinations of bars and spaces represent numerals, letters, and
other characters,

Bar Space

l |
IR

ABOUT BAR CODES 7
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Most bar code symbologies fall into one of two groups. The older
formats use only two widths for bars and spaces. To read this kind
of bar code, scanners only need to distinguish white, black, wide,
and narrow. Wide bars and spaces represent binary ones, and
narrow bars and spaces represent binary zeros. Examples of this
kind of bar code include Code 39, 2 of 5 Interleaved, and
Codabar.

The newer bar code symhologies use up to four widths for bars
and spaces. To read this kind of bar code, scanners perform
edge-to-edge measurement pattern recognition. Examples of this
kind of bar code include Code 128, Code 11, Code 93, and the
Universal Product Code (UPC).

The left and right ends of a bar code must be separated from
other markings by white areas called qutiet zones. Quiet zones
enable scanners to distinguish the bars and spaces from other
printed information, and to determine the “white” color of the
spaces. Mac-Barcode automatically displays quiet zones for you on
either side of your bar codes. These quiet zones should be left
blank. If you put text or pictures in the quiet zones, it will make
the bar code impossible to read.

Quiet Quiet
Zone Zone
— — —

One of the important characteristics of a bar code is the thickness
of its narrowest bars, called the X-dimersion. The widths of all the
bars and spaces in a bar code are multiples of the X-dimension:
one times X, two times X, three times X, and so forth.

X-Dimension

' |

8 ABOUT BAR CODES
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Mac-Barcode allows you to control the X-dimension of the bar
codes you create. In choosing an X-dimension for a bar code, you
must take into account the optical performance of the scanner that
will be used to read the code. If you select an X-dimension that is
too small, the scanner may not be able to read the bar code.
Larger X-dimensions usually allow laser scanners to read bar
codes at greater distances.

How to Choose a Bar Code Symbology

When choosing a bar code symbology for an application, you
should consider the following items:

Industry standards. Some industries use a standard bar code
symbology. For more information on standards in specific
industries, see “For Further Information” on page 59.

Your customer’s requirements. Your customer may require
you to use a specific bar code symbology.

The characters you wish to print as bar codes. Some bar
code symbologies can only represent numbers. Others can
represent numbers and one or more other characters. A few
symbologies can represent all of the 128 ASCII characters that are
used by most microcomputers. A list of characters that can be
printed with each bar code symbology is shown in the table on
the next two pages under the heading “Characters Represented.”

The number of characters you wish to put in the bar
codes. Most bar code symbologies allow you to vary the number
of characters in a bar code symbol up to a maximum of 31. These
symbologies are identified as variable in the table on the next two
pages under the heading “Number of Characters in a Bar Code.”
With some symbologies, however, the scanner must be set to read
a specific number of characters. With such symbologies, all bar
code symbols that are scanned at one time must contain the same
number of characters. These symbologies are identified as fixed in
the table. The UPC format is a special kind of fixed-length
symbology. It only allows you to represent 6 or 11 characters in a
bar code symbol.

HOW TO CHOOSE A BAR CODE SYMBOLOGY 9
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Bar Code Symbologies Supported by Mac-Barcode

Characters Number of Characters
Symbology Represented in a Bar Code
Code 128 All 128 ASCIT Variable;
characters any number up to 31
Code 39 AZO9 + §/- Variable;
<space>> any number up to 31
20f5 0-9 Fixed; scanner must be set (o
Interleaved the number of characters in
each bar code, which can be
any even number up to 30.
Mac-Barcode adds a leading
zero to bar codes with an odd
number of characters.
Codabar 0-9-§%./. + Variable;
ABCD any number up to 31
Code 93 All 128 ASCII Variable;
characters any number up to 31
UPC 0-9 Fixed; 11 digit code with ¢
digit representation
Code 11 0-9 - Variable;
any number up to 31

10 MAC-BARCODE SYMBOLOGIES
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Typical Uses

Remarks

Industrial applications, shop
floor documents, CRT input

Most compact for long
numeric data strings; compact
for mixed alphanumeric data
strings. Well suited for dot
matrix printers.

Department of Defense
procurements, auto industry

Very reliable. One of the two
most popular industrial bar
code symbologies. Produces
long bar code symbols.

Industrial applications, food
cases, auto components,
sortaticn labels, warchousing

One of the two most popular
industrial bar code formats.
Used in applications where all
the bar codes have the same
number of characters.

Medical filing,
photoprocessing, libraries

Codabar is the Red Cross
blood banking standard.

Industrial applications

Compact; minimizes the
length of codes that represent
long strings of data. Well
suited for dot matrix printers.

Grocery and drug products,
medical industries

Developed as a retail
point-of-sale bar code
standard.

Industrial applications

A new symbology.

MAC-BARCODE SYMBOLOGIES 1



The amount of space available for the bar code symbols.
Different bar code symbologies produce bar code symbols of
different lengths. If you have a limited amount of space for your
bar code symbols, you can use Mac-Barcode to encode a typical
bar code symbol in several suitable symbologies and then choose
the shortest one. Symbologies that usually produce short bar code
symbols are identified as compact or very compact in the table on
the previous two pages under the heading "Remarks.”

12 ABOUT BAR CODES
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3. Using Mac-Barcode

This chapter is designed to get vou started using Mac-Barcode.
The first section explains how to run the Mac-Barcode program on
your Macintosh computer. The next few sections present brief
summaries of Mac-Barcode’s tools and commands. The final
section of this chapter coaches you through a sample Mac-Barcode
session in which you create and print a bar code.

Starting Mac-Barcode

To use the Mac-Barcode program, you need a Macintosh computer
and an Apple Imagewriter printer. You should also know how to
use the Macintosh mouse and desktop, and how to start Macintosh
programs. These basic operations are explained in Apple’s
Macintosh manual.

Before you start Mac-Barcode for the first time, you should make
at least one backup copy of the Mac-Barcode disk. The Apple
Macintosh manual explains how to do this under the heading
“Copying an Entire Disk.”

To begin, turn on the Macintosh and its printer, and insert the
Mac-Barcode disk or a backup copy of it. When the desktop
appears on the screen, yvou can “open” the disk by placing the
pointer on top of the symbol that represents the disk and clicking
the mouse button twice. The contents of the disk will be displayed
as shown in the illustration at the top of the next page.

STARTING MAC-BARCODE 13
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The CI symbol represents Mac-Barcode. To start the program,
move the pointer on top of the CI symbol and click the mouse
twice. The Mac-Barcode screen will appear:

File Edit Bar Codes Fonts Style Labels Uiewing

14 USING MAC-BARCODE
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The screen initially has four areas. They are the Tool Palette, the
Menu Bar, the Work Window, and the Bar Code Data Window.

The Tool Palette

The Tool Palette contains six icons, each of which represents a
different tool or object that you can use in Mac-Barcode. To select
any of these tools, move the pointer to the appropriate icon and
click once. Then move the pointer into the Work Window, where
it will change into an image that represents the tool you just
selected. To perform work with the tool, press the mouse button.
After you've used the tool once, the pointer will revert to its usual
form. To use a tool again, you must select its icon again.

® File Edit Bar Codes Fonts §

The Bar Code Tool is used to create a bar code in the
I”I] " Work Window. The pointer appears as a scope when this
tool is selected. For more information on use of the Bar
Code Tool, see Chapter 5.

@

THE TOOL PALETTE 15
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The Label Tool is used to produce a label in the Work
Window. The pointer appears as a scope when this tool is
selected. For more information on use of the Label Toaol,
see Chapter 6.

The Easel Tool is used with the Paste command to
position and change the size of text and artwork. The
pointer appears as a scope when this tool is selected. For
more information on the Easel Tool, see Chapter 9.

The Pen Tool is used to draw in the Work Window. The
pointer appears as a pen when this tool is selected, For
more information on the Pen Tool, see Chapter 8.

The Text Tool is used to type text in the Work Window.
The mouse pointer appears as a scope when this tool is
selected. For more information on the Text Tool, see
Chapter 7.

The Hand Tool is used to reposition the Work Window
on the work page. The pointer appears as a hand when

this tool is selected. For more information on the Hand

Tool, see Chapter 9.

The Menu Bar

The Menu Bar provides vou with a choice of eight different
pull-down menus. These menus contain commands. Some of the
commands modify the way the Mac-Barcode tools work. Other
commands perform tasks on their own, such as printing labels.

®

File Edit Bar Codes Fonts Style Labels JTIOIOW 2= |
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Show Preview Page
Print Page
Print Sejecied Labal

Print Alignment Label

Show Item Outlines

USING MAC-BARCODE
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The menus can be used at almost any time during Mac-Barcode
operation. To select a command from a menu, move the pointer
to the appropriate position along the Menu Bar and click. The
contents of the menu will appear directly below the pointer.
While pressing the mouse button, move the pointer down the
menu to the desired command. Finally, release the mouse button
to select the command and perform the desired operation.

From time to time while you're using Mac-Barcode, some of the
menu commands will appear in dim type. This indicates that those
commands are temporarily unavailable because they are not
needed or because Mac-Barcode is busy with something else. For
example, in the previous illustration “Print Selected Label” is
dimmed because no label has been selected, and therefore no
selected label can be printed. When a menu command is dimmed,
choosing it has no effect.

The Apple Menu contains the standard Macintosh desktop
accessories such as the Alarm Clock and Notebook. The Apple
Macintosh manual explains how to use these accessories.

The File Menu lets you save Mac-Barcode work pages on disk. It
also contains commands for re-opening saved work pages and for
merging the contents of two work pages into one. In addition, the
command for finishing a Mac-Barcode session is on the File Menu.
For more information on the File Menu, sce Chapter 4.

The Edit Menu contains the standard Macintosh editing functions
Undo, Cut, Copy, and Paste. You can use these functions to move
pictures, text, labels, and bar codes in and out of the Work
Window via the Clipboard. The Clear function erases the entire
work page. For more information on editing, see Chapter 9.

The Bar Codes Menu allows you to select the bar code
symbology you wish to use. Other options on this menu control
the size and appearance of the bar codes that you create with the
Bar Code Tool. For more information on creating bar codes, see
Chapter 5.

THE MENU BAR 17
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The Fonts Menu allows you to select the typeface to be used for
bar code interpretations and text. The default font is Geneva.
Additional fonts may be added to the Mac-Barcode disk with
Apple’s FontMover application. For more information on fonts and
typing text, see Chapter 7.

The Style Menu allows you to select the style and size of text and
the size of bar code interpretations. For more information on the
Style Menu and typing text, see Chapter 7.

The Labels Menu allows vou to define the size and appearance
of labels that you create with the Label Tool. You can select one of
six common label sizes that are listed on this menu, or you can
define your own label size with the Specify Dimensions command.
For more information on labels, see Chapter 6.

The Viewing Menu contains options for controlling the position
and appearance of the Work Window. Commands to print the
contents of the Work Window are also on this menu. For more
information on the Viewing Menu, see Chapter 9.

The Work Window and the Bar Code Data
Window

Two windows are always present on the Mac-Barcode screen. The
large, unlabeled window is the Work Window. The smaller
window below the Work Window is the Bar Code Data Window.

The Work Window is where you place the images you want to
print. This window shows part of the Mac-Barcode work page,
which is 8 inches wide by 11 inches high. To move the Work
window to a different part of the work page, you can use either
the Hand Tool or the Preview Page command on the Viewing
Menu. You can place images in the Work Window with the Bar
Code Tool, Label Tool, Pen Tool, and Text Tool, and with the
Paste command which appears on the Edit Menu.

18 USING MAC-BARCODE
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The Bar Code Data Window shows the characters that will be
encoded as a bar code when you use the Bar Code Tool. To enter
data into this window, maove the pointer to the window and press
the mouse button. Then type on the keyboard. You can edit the
data with the standard text editing techniques described under
“Editing Text” in the Apple Macintosh manual.

A Sample Mac-Barcode Session: Creating a
Bar Code

The following sample session illustrates the most important steps
in producing a bar code label.

Step 1. If you have not already done so, turn on your Macintosh,
insert the Mac-Barcode disk, and click twice on the Mac-Barcode
icon.

Begin by entering the data that you wish to represent as a bar
code. Move the pointer down to the Bar Code Data Window and
click once. Several horizontal lines will appear on the window’s
title bar, showing that it is now active, and a blinking bar will
appear at the left side of the window,

Bar Code Data =
I J

Now type the characters “123456” as sample bar code data. If you
make a mistake while typing, use the Backspace key to correct it.

Bar Code Data =

123456 /(

A SAMPLE MAC-BARCODE SESSION 19
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Step 2. Next, select a bar code symbology by moving the pointer
to the Bar Codes Menu label near the top of the screen. Click and
hold the mouse button. This menu will appear:

Bar Codes pfonts  Style

vDisplay Horizontally [
Display UDertically

vDisplay Interpretation
Code 128

«Code 39

2 of 5 Interleaved

Codabar

Code 93

urcC

Code 11

Change H-Dimension

Change Bar Height

Create Compressed
vCreate Preferred

20 USING MAC-BARCODE
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The middle portion of the menu offers a choice of seven bar code
symbologies. Right now, Code 39 is selected. To change to 2 of 5
Interleaved, hold down the mouse button and move the pointer to
“2 of 5 Interleaved.” Then release the button.

Edit QELTEWLEEE Fonts  Style
vDisplay Horizontally =
Display Dertically

vDisplay Interpretation

Code 128
vLCode 39

2 0f 5 Interleaved

Codabar
Code 93
UPC .
Code 11

Change H-Dimension

Change Bar Height

Create Compressed
«LCreate Preferred

A SAMPLE MAC-BARCODE SESSION 21
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Step 3. The next step is to create a bar code symbol on the work
page. Move the pointer to the bar code icon on the Tool Palette.
Click once. Then move the pointer into the Work Window. The
pointer will become a scope. Move the scope to the place on the
work page where you want the bar code to appear and click once.
The bar code symbol and interpretation will appear.

File Edit Bar Codes Fonts Style Labels Uiewing

123456

Bar Code Data

22 USING MAC-BARCODE
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Step 4. The next step is to make a label and put the bar code
symbol inside it. Move the pointer to the word “Label” on the
Menu Bar and hold the mouse button down. The Labels Menu will
appear:

Stgle Labels s Viewing

: 1~Display Horizontally
Display Vertically
Specify Dimensions
Specify Inter-Label Gap

v3.0" # 15-16"
3.5" H 15-16"
4.0" # 15-16"
3.5"8#1 716"

4.0"# 1 7-16"

2.0"# 1 ?-16"

Free Form

Left Justify

Right Justify
vLCenter Justifg

A SAMPLE MAC-BARCODE SESSION 23
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The menu is already set up for horizontal labels that are 3 inches
wide and 1% inch high. In addition, the menu specifies that bar
codes will be centered inside their labels. If you wish, you can
select different options from the menu, just as you did in Step 2
above. Otherwise, release the mouse button to keep the options
that are already selected. Move the pointer to the Label Tool icon
on the left side of the screen and click once. Then move the
pointer into the Work Window. Once again, the pointer will
become a scope. Move the scope to a clear area on the work page
and click the mouse button. The label will appear. Now move the
pointer to the bar code symbol and click to select it. While
holding the mouse button down, move the bar code image inside
the label. Release the mouse button.

123456

Step 5. You're now ready to print the bar code. For this sample
session, you can use whatever kind of paper you happen to have
in your Imagewriter printer. Chapter 10 of this manual explains

how to print on continuous form labels.

Make sure the label on the work page is selected by clicking it
once. Then pull down the Viewing Menu and choose Print
Selected Label. A dialog box will appear on your screen. Move the
pointer to the Continue button in the lower right corner of the
box, and click once. The dialog box will be replaced by another
dialog box. Make sure your printer has paper and is ready. Then
click the Continue button of the second dialog box.

24  USING MAC-BARCODE
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Enter the number of copies desired: lil

[ Continue |
Cancel |

First Barcode Sequence |JESE 5T

Final Barcode Sequence |123456

[ Continue |
| Cancel

Congratulations! You have printed a bar code symbol using the
Macintosh and Imagewriter printer,

Selecting and Dragging

When you create a bar code, it appears on the screen inside a
shaded rectangular area. If you then select a tool or click on a
blank area of the screen, the shading disappears from around the
bar code. When the shading is present, the bar code is in a
selected state. When the shading disappears, you are seeing the bar
code as it will actually appear when printed.

To select a bar code or other object, put the pointer on it and

click the mouse. To “un-select” the object, click on some other
part of the screen.

SELECTING AND DRAGGING 25
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012345678

0123456789
When objects are selected, they can be moved around the Work
Window by dragging them with the mouse. To drag an object,
place the pointer on it. Hold the mouse button down and pull the
object to its new location by moving the mouse. When the object
is where you want it, release the mouse button.

Selected

Not Selected

The procedures for selecting and dragging text boxes are slightly
different from the ones used with other objects. See page 45 for
more information.

26 USING MAC-BARCODE
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4. The File Menu

The File Menu lets you save Mac-Barcode work pages on disks. It

also contains commands for re-opening saved work pages and for
merging the contents of two work pages into one. In addition, the
command for finishing a Mac-Barcode session is on the File Menu.

New
Open
Merge
Save
Save As ...

OQuit %0

New

The New command places a blank work page in the Work
Window. If you select New while working on an old work page,
Mac-Barcode asks if it should save the old work page before
giving you a new one. If you answer no, Mac-Barcode discards the
old work page.

When you start a Mac-Barcode session by double-clicking the CI

icon on the Macintosh desktop (see page 14), Mac-Barcode
automatically gives you a new work page.

THE FILE MENU 27
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Save

The Save command places a permanent copy of a work page on a
disk.

Until you select Save, your work page is stored only in the
Macintosh’s temporary memory. If the computer’s plug is
accidentally pulled from the vvall, everything in memory vanishes,
including your work page. You should select Save frequently as
you work with Mac-Barcode to keep an up-to-the-minute copy of
your work page stored safely on disk.

The first time you Save a new work page, Mac-Barcode will
present you with the following dialog box:

Save Worksheet As: Computer ...

Use this dialog box to type in the file name under which the work
page will be saved. If you don’t want Mac-Barcode to save the file
on the disk currently in use, click the Eject button to switch to
another disk. Then click the Save button to save the work page. If
you change your mind, click the Cancel button instead.

When you save a work page that has been saved at least once
before, Mac-Barcode erases the old saved version of the work
page from the disk and stores the newer version in its place. If
you wish to Open an old work page, change it, and save both the
old and new versions on disk, you must use the Save As
command, which is discussed below.

28 THE FILE MENU
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Open

The Open command is used to bring a saved work page back into
the Work Window from a disk file so you can examine it, change
it, copy it, or print it.

When you select Open from the File Menu, the following dialog
box appears on the screen:

Parts 100-199 [
Parts 200-299 dnan Computer I...
Worksheet 388

Worksheet 40

Worksheet 40A

( cancel ] | [ Drive |

]

This dialog box lists all the files on the current disk that were
created by Mac-Barcode. To work on a particular one, click its
name and then click the Open button. If the file you want to work
with is on another disk, click the Eject button.

Save As

The Save As command allows you to copy an existing work page
file and save it under a new name on disk. You should use this
command when you want to make changes to a work page and
then save the new version while retaining the old version.

To put the new copy of the file on a different disk, click the Eject
button on the Save As dialog box before clicking the Save button.

Merge

The Merge command combines the contents of two work page
files in a single file.

MERGE 29
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In order to merge two files, one of them must be in the Work
Window and the other must be saved on disk. When you are
ready, select Merge from the File menu. This will cause the Open
dialog box to appear. Select the name of the saved work page file
and click the Open button. The contents of the saved work page
will be placed directly on top of the contents of the one in the
Work Window.

Quit
The last command on the File Menu is Quit. Select this command

when you are finished using Mac-Barcode and wish to return to
the Finder desktop.
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5. Bar Codes

The Bar Codes Menu offers a choice of seven bar code
symbologies that you can use for your bar codes. It also lets you
change the size and appearance of your bar codes in a number of
ways. This section explains in detail how to use the Bar Codes
Menu.

Xilld Bar Codes
S whisplay Horizontally

Display Dertically
vDisplay Interpretation

onts Style

Code 128
+LCode 39
2 of 5 Interleaved
Codabar
Code 93
UPC
Code 11

Change H-Dimension

Change Bar Height

Create Compressed
vLCreate Preferred
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Interpretation

To turn off Display Interpretation, select it with the mouse. To
turn it back on, select it again. When Display Interpretation is on,
a check mark appears next to it on the menu.

If you turn Display Interpretation off, bar codes will be produced
without any text defining the characters they represent. It is not
possible to turn off Display Interpretation when using the UPC
format, because UPC symbols by definition require a
human-readable interpretation.

Mac-Barcode lets you drag an interpretation to any position in the
Work Window:.

|H|| ||\ i
6744 ) “’l ”’
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Selecting a Bar Code Symbology

In the middle section of the Bar Codes Menu, seven different bar
code symbologies are listed. At any time, only one of these
symbologies can be selected. Descriptions of the symbologies are
given in the table on pages 10-11.

Once you have selected a symbology, all bar codes produced with
the Bar Code Tcol will appear in that symbology. You can change
the symbology of an existing bar code by first clicking it and then
choosing a different symbology from the Bar Codes Menu.

When the UPC symbology is checked on the Bar Codes Menu, you
have to perform an additional step each time you select the Bar
Code Tool to create a bar code. This dialog box will appear on
the screen:

Manufacturer's Code: LUPC Code A

Product Number: 999499 UPC Code E

Cancel

2 |

Number System:

This box allows you to specify the manufacturer’s code and
product number to be represented in the UPC bar code. Both of
these are five digit numbers. To enter them, click the
manufacturer’s code box and then type the manufacturer’s code.
Next, click the product number box and type in the product
number. In addition, you can select a number system code. This is
the single digit that appears to the left of the bar code in a UPC
symbol.
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Finally, you must select one of the two dialog box buttons at the
right of the box. These are used to choose either UPC Code A or
UPC Code E. A cancel button is also provided on the dialog box,
in case you decide you do not wish to use the UPC format after

all,
g " ’III II .I ’I Hl" o
99 99 949
g || ll’lll |.||Il I'l -
9 9 9 99 9 9 99

Select X-Dimension

The X-dimension is the thickness of the narrowest bar in a bar
code symbol. By changing the X-dimension, you change the length
of the whole bar code. (For more information on the
X-dimension, see page 8.)

To choose the X-dimension of a bar code, first select the bar code
format you wish to use. Then pull down the Bar Codes Menu and
select Change X-Dimension. This dialog box will appear on your
screen, as shown at the top of the next page.
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Enter the minimum bar size in pizels:

(1/80" horizontally) @ [ Continue |
(1/72" vertically.)

The X-dimension is specified in %o inch units. Mac-Barcode will
set the X-dimension to Yo inch unless you give it some other
number. You can change the X-dimension to any number of units
from Y50 to Yo by typing the value desired and clicking the
Continue button. All subsequent bar codes that you create will be
displayed with the new X-dimension. Note that larger
X-dimensions produce bar codes that occupy more space on the
work sheet.

When printing vertical bar codes, the X-dimension units increase
11 percent in size to Y72 inch.

You can use this command to change the X-dimension of a bar
code that already exists. Select the bar code and then use the
Change X-dimension command to choose a new number.

Change Bar Height

This command allows you to set the height of bar codes. To use
this option, first select the bar code symbology you wish to use

from the Bar Codes Menu. Then pull down the Bar Codes Menu
again and select Change Bar Height. This dialog box will appear
On your screen:

Enter the bar code height in 16ths

of an inch (0.0625"): [ Continue |
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The current bar height is specified in ¥1s inch units. Mac-Barcode
will set the height to 8 units, or ¥2 inch, unless you give it some
other number. If you change this value to 4 units, the bar codes
produced will be ¥4 inch high. If you change this value to 12
units, the bar codes produced will be % inch high. Type the value
you want and then click the Continue button. As always, the
Cancel button lets you change vour mind and abandon any
changes.

You can use Change Height to alter an existing bar code. Select
the bar code and then use the Change Height command to
specify a new height.

Create Preferred and Create Compressed

These commands can be used only with Code 2 of 5, Code 39,
and Codabar. Only one of these commands may be selected at a
time. The Create Preferred option produces bar codes with an
adjusted 3 to 1 ratio in the widths of wide and narrow bars. This
ratio complies with national standards. The Create Compressed
option produces bar codes with a 2 to 1 ratio. This ratio produces
more compact bar code symbols. The choice of which to use
depends on your particular application.

IRV

Preferred

Compressed
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Special Code 128 Feature

To create any arbitrary Code 128 character, type the Backslash Key
(\) while holding the Option Key, followed by the three-digit
Code 128 representation. This feature can be used to create setup
labels or special control characters.

Appendix B on page 61 contains a table of three-digit Code 128
representations.

38 BAR CODES



6. Labels

The Labels Menu lets you set the shape and size of the labels on

which you wish to print with the Imagewriter printer. It also
provides commands that affect the appearance of the labels and
the placement of bar codes within them.

The Labels Menu locks like this:

Style ELTER Viewing

wDisplay Horizontally
Display Pertically
Specify Dimensions
Specify Inter-Label Gap

+3.0" R 15-16"
35" #15-16"
40" # 15-16"
35"#17-16"
40"=#17-18"
5.0"x®17-16"
Free Form

Left Justify
Right Justify
vCenter Justify

LABELS
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Display Horizontally and Display Vertically

These commands work just like their counterparts in the Bar
Codes Menu. They allow you to choose the orientation of labels
that you create with the Label Tool. Only one of these commands
can be selected at a time, and Mac-Barcode displays a check mark
next to the one that is selected.

Specify Dimensions

The middle section of the Labels Menu offers you a choice of six
popular label sizes, These sizes range from three to five inches
wide, and are either %6 or 171¢ inches high. If the labels you
intend to use match any of the sizes shown here, you can select
the appropriate one from the Labels Menu.

Mac-Barcode does not limit you to the label dimensions listed in
the Labels Menu. Instead of selecting one of the listed sizes, you
can use the Specify Dimensions command to set the size of labels
up to a maximum width of 6 inches and a maximum height of 5
inches. When you select Specify Dimensions, this dialog box appears
on the screen:

Label Width: |2 |and |0 -16th's inches.
Label Height: |0 |and |8 -16th's inches.

> n

Cancel

There are four entry fields in this dialog box. They allow you to
specify the label width and height. For each dimension, you must
enter two numbers: the number of full inches, and the number of
sixteenths of an inch. For example, you would specify a 2 X 2
inch label by entering a width of 2 full inches and 0 sixteenths of
an inch, and a height of 0 full inches and 8 sixteenths of an inch.
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To enter the numbers, first click the mouse in the appropriate
field to highlight it, and then type the number desired. When you
have completed all four entries, click the Continue button to exit
from the dialog box.

Once label dimensions have been specified, all subsequent labels
produced with the Label Tool will appear in that size. To change
the dimensions of an existing label, select it and then use the
Specify Dimensions command.

Specify Inter-Label Gap

The Specify Inter-Label Gap command allows you to set the
vertical distance between adjacent labels when using continuous
forms in the Imagewriter printer. When you select this item from
the labels menu, the following dialog box will appear:

Enter spacing between labels in 16ths

of an inch (0.0625"): [Continue |

The Inter-Label Gap is specified in units of s inch. If you set the
number to 8, for example, the gap will be 8s or ¥ inch.
Mac-Barcode will set the Inter-Label Gap to Vis unless you select a
different number. You can set the Inter-Label Gap to any value
between Y46 and 1%46. Click the Continue button to exit from this
dialog box.

Note that the Inter-Label Gap affects printing operations only. It
does not change the appearance of the work page.
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Free Form, Left Justify [Top Justify), Right Justify
{Bottom Justify), Center Justify

These four commands determine where a bar code will be placed
within a label. Only one of these commands can be selected at a
time. Mac-Barcode displays a check mark to show which command
is selected.

Center Justify centers the bar code within the label. Left Justify
moves the bar code to the left side of the label. Right Justify
moves the bar code to the right side of the label. Free Form
allows you to put the bar code anywhere you want inside the
label.

] i

Left Justify T Right Justify T
Free Form ‘ Center Justify i

When Display Vertically is selected on the Labels Menu, the name
of the Left Justify command changes to “Top Justify,” and the name
of the Right Justify Command changes to “Bottom Justify.” You can
use these commands to change the position of a bar code that has
already been placed inside a label. Select the label and then
choose the new justification option from the menu,
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7. Text

The Text Tool allows you to add text to labels and work sheets.
The tool itself creates a text box in the Work Window. This box
can then be filled with text by typing on the keyboard. The
appearance of the text can be changed with the Fonts and Style
menus.

The Text Tool

To use the Text Tool, click its icon on the Toaol Palette. Then
move the mouse pointer into the Work Window, where it will
appear as a scope. Place the scope at the upper left corner of the
area of the work page where you wish to place text. Drag the
mouse downward and to the right to create a text box. When the
rectangle is big enough to hold the text you wish to type, release
the mouse button.

® File Edit Bar Cod

es Fonts Style

R R
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The blinking bar at the upper left corner of the box shows the
place where typed characters will appear. Once there is some text
in the box, you can reposition this blinking bar by clicking the
new location with the mouse.

% File Edit Bar Codes Fonts Style

e,

‘You can change the size
0f & text box after text is |
‘entered, and the lines
will automatically adjust :

o the new width] :

Words automatically wrap around to the next line when they
reach the right edge of the box. To start a new line or skip one,
use the Return Key.

You can change the size of a text box by dragging the small black
square at its lower right corner. When vou release the mouse
button, the text window will be fixed at its new size, and the text
inside it will be adjusted to fit.

Editing Text

You can edit text inside a text box with the same techniques used
in most Macintosh programs. For more information, see “Editing
Text” in the Apple Macintosh manual.
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The Fonts Menu and Styie Menu

When you type into a text box, text appears in the type face and
point size selected on the Fonts Menu and Style Menu.

Los Angeles | +Plain Text
Cairo Bold
Chicago flalic
Chicago Underline
+Geneva 0[ujtillinfe]
New York Shadomm
Uenice 9 Point
London 10 Point
Athens +12 Point
18 Point
20 Point
24 Point

Mac-Barcode automatically selects plain Geneva in a 12 point size
unless you choose other options. Your choice of styles includes
boldface text, italicized text, shadowed text, and outlined text. The
text size may range from 9 point (the smallest) to 24 point (the
largest).

You can use the Fonts Menu and Style Menu to change the
appearance of existing text and bar code interpretations. First
select the text box or interpretation you wish to change, and then
choose the new font and style options.
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All the text in a text box must use the same font, size, and style.

Selecting and Dragging Text

The procedures for selecting and dragging text are slightly
different from the ones used with other objects. If vou click on
text, the text itself becomes selected. This allows you to edit it If
you click on a blank area inside an unselected text box, the text
box becomes selected. This allows you to drag the box. If you
click on a blank area inside a selected text box, the blinking bar
moves to a new text insertion point.

Unlike other objects, a text box cannot be dragged when it is

selected. If the box is selected, first “un-select” it by clicking
elsewhere on the screen. Then drag it.
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8. The Pen

The Pen Tool allows you to add simple line drawings to your
work sheets and labels. This is especially useful if you want to
include diagrams or reference marks.

To use the Pen, move the pointer to the Pen icon on the Tool
Palette and click once. Then move the pointer back into the Work
Window, where it will change in appearance to a quill pen.

Maove the Pen to the starting point for your drawing. Hold down
the mouse button and move the mouse. The Pen will follow the
movement of the mouse and draw a line. As soon as you release
the mouse button, the Pen will stop drawing. To continue
drawing, click the Pen icon again on the Tool Palette.

% File Edit Bar Codes Fonts Style
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A line drawing can be dragged, just like any other Mac-Barcode
object,

It is not possible to change the appearance of a line drawing once

it has been made. To delete a line drawing, select it and choose
Cut from the Edit Menu.
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9. Editing the Work Page

Earlier sections of this manual explain how to create the four
kinds of objects that can be produced with Mac-Barcode. These
objects are:

— Bar Codes

— Labels

— Text Boxes

— Line Drawings

In this section, you will learn how to move and modify objects,
how to delete objects, and how to cut and paste objects to and
from the Macintosh Clipboard.

Mac-Barcode Objects

When Mac-Barcode objects are first created, and when you click
them, they become selected. Objects that are in this selected state
can be dragged around the work page with the mouse. They can
also be altered by choosing new options for them from the
menus. For instance, the height of an existing bar code can be
changed by first clicking it and then choosing a new Bar Height
value from the Bar Codes Menu.

Show Item Outlines and Hide Item Outlines

To prevent you from accidentally obscuring quiet zones,
Mac-Barcode has commands called “Show Item Outlines” and
“Hide Item Outlines.” (For more information on quiet zones, see
page 8.) You select these commands from the Viewing Menu.
When Show Item Outlines is selected, rectangular boxes appear
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around all the objects in the Work Window. The boxes show the
sizes of the objects as they appear when they are selected,
including quiet zones around bar codes.

Outlines are never printed.

The Hide Item Outlines command makes the rectangular boxes
disappear.

Bar Codes

% File Edit Fonts Style

Special
Order
10/28

123456

Hide Item Outlines

Fonts Style

22458

Show Item Outlines
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The Edit Menu and Clipboard

The Edit Menu lets you erase, copy, and move objects on the work
page. It also allows you to move images from Mac-Barcode to
other programs such as MacPaint and MacWrite, and from other
programs into Mac-Barcode.

""" Undo %7
Cut 3 H
Copy &C
Paste 3D
Clear

The Edit Menu does most of its work through the Clipboard, an
invisible holding area in the Macintosh’s memory. When you
choose Cut or Copyv from the Edit Menu, the selected image is
stored on the Clipboard. When you choose Paste from the Edit
Menu, the invisible image on the Clipboard is put back on the
work page. These features can be used to crasc images, move
them, and duplicate them.

Only one object at a time can be stored on the Clipboard. Every
tfime you cut or copy an object to the Clipboard, whatever was
previously stored on the Clipboard is lost.

The Clipboard is part of Macintosh, so many application programs
make use of it. You can cut pictures from Apple’s MacPaint
program, or text from Apple’s MacWrite program, and paste them
into Mac-Barcode. You'll find more information on cutting and
pasting in the sections that follow.
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Undo

This command undoes the effects of your most recent action, if
possible.

Cut

The Cut command removes selected objects from the work page
and puts them on the Clipboard. An object that has been cut can
be restored to the work page with the Paste command,

Copy

The Copy command puts a duplicate of an object on the
Clipboard. The difference between Cut and Copy is that Cut
removes an object from the work page, but Copy does not.

Copy is useful for duplicating an object on the work page. To use
Copy in this way, select the object and choose Copy from the Edit
Menu. This will place the selected object on the Clipboard without
removing it from the work page, as Cut would do. Then select
Paste from the Edit Menu.

You can make as many duplicates of the object as vou wish by
repeatedly selecting Paste from the Edit Menu,

Paste

The Paste command copies the image on the Clipboard and places
the copy on the work page. The image remains on the Clipboard

after it has been pasted, so you can use Paste several times in a
row to put multiple copies of the same image on the work page.

Clear

The last item on the Edit Menu, Clear, erases the entire work
page.
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The Easel Tool

The Easel Tool is used with the Paste command to position and
change the size of objects. The Easel Tool defines a rectangular
area on the screen where the pasted image will appear, and
whatever is pasted automatically shrinks or expands to fill the
rectangle.

To use the Easel Tool, move the pointer to the Easel icon in the
Tool Palette and click once. Then move the pointer back into the
work page area, where it will change into a scope. Move the scope
to the upper left corner of the area on the work page where you
want to paste the shrunken or expanded image. While pressing
the mouse button, drag down and to the right. As you do so, the
outline of a rectangle will appear. When the rectangle encloses the
desired area, release the mouse button. Then select Paste from the
Edit Menu.

‘The Easel Tool should not be used to paste bar codes because it
may change the thicknesses of bars and spaces, making them
unreadable. To change the size of bar code symbols, use the
Change X-Dimension and Change Bar Height commands on the
Bar Code Menu.

Cutting and Pasting with Other Programs

You usually can cut images from a Mac-Barcode work page and
paste them onto a document in another program. Conversely, you
can usually cut text or drawings from a document in another
program and paste them onto a Mac-Barcode work page.

Some kinds of objects cannot be pasted into certain programs.

Preview Page and the Hand Tool

The Mac-Barcode work page measures 8 inches wide and 11
inches high, but the Work Window can only show you a portion
of it at a time. To see the entire work page, pull down the
Viewing Menu and select the Preview Page command. This will
cause a new window to appear on your screen, as shown at the
top of the next page.
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& File Edit Bar Codes Fonts Style Labels Uiewing

Bar Code [}

BE775RIH

The Preview Page window shows a reduced view of the entire

8 X 11 inch work page. The rectangle inside this window
indicates the part of the work page that is currently on view in the
Work Window. The Work Window initially shows the upper left
corner of the work page.

To move the Work Window to another part of the work page,
place the pointer inside the rectangle in the Preview Page
window. Then click and drag the mouse. In this way, you can
move the Work Window to any part of the work page,

To remove the Preview Page window from your screen, click on
its close box, which is the small square in the upper left corner of
the window, or choose Hide Preview Page from the Viewing
Menu.

You can also move the Work Window with the Hand Tool. To use
this feature, place the pointer on the Hand Tool icon on the Tool
Palette and click once. Then move the peinter into the Work
Window. The pointer will change from an arrow into a hand as
soon as it enters the window. Hold the mouse button and drag
the mouse to re-position the Work Window.
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10. Printing

Mac-Barcode lets you print either the entire 8 X 11 inch work
page or selected labels. Printing operations are performed with
commands from the Viewing Menu. When pulled down, the menu
looks like this:

Show Preview Page
Print Page

Frind Highifaghied Label
Print Alignment Label

Show Item Outlines

Print Page

To print the entire 8 X 11 inch work page, select the Print Page
option. The following dialog box will appear on the screen:

Enter the number of copies desired:

[ Continue |
Cancel ]
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This dialog box allows you to specify how many copies of the
work page to print. Mac-Barcode automatically sets this number to
1, but you can change it to any number up to 999. Click the
Continue button to begin the printing operation. If you change
your mind and decide not to print, click the Cancel button. Keep
in mind that Print Page prints the entire 8 X 11 inch work page,
not just the portion that is currently visible in the Work Window.
While printing is in progress, a dialog box will appear offering a
Cancel button. Use this button if you wish to cancel the printing
operation before it finishes.

Now printing the requested material.
Press Cancel to halt printing process.

Cancel

Print Alignment Label

The Print Alignment Label command prints rectangular boxes that
are the same size and shape as the label you have selected. This
command is useful for aligning continuous form labels in the
Imagewriter printer.

When you select this command, the following dialog box will
appear:

Enter the number of copies desired: E]

(Tontinue )
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This dialog box allows you to specify how many alignment labels
will be printed. Print at least two to check whether the Inter-Label
Gap is set correctly for the forms you are using. After selecting the
number of labels desired, click the Continue button to begin the
printing operation. If you change your mind and decide not to
print, click the Cancel button.

Print Selected Label

This command is used to print on continuous form labels. Before
using it, the continuous form labels should be lined up in the
printer with Print Alignment Label.

Select the label you wish to print by clicking it. Then choose Print
Selected Label from the Viewing Menu. The Number of Copies
dialog box will appear. (It is illustrated at the bottom of the
previous page.) This dialog box allows you to specify how many
copies of the label will be printed. Mac-Barcode automatically sets
the number to 1, but you can change it to any number up to 999.
When you click the Continue button, another dialog box will
appear:

First Barcode Sequence |[PEEELD

Final Barcode Sequence |123456

[ Continue |
Cancel

This dialog box gives you the option of printing a series of labels
with consecutive numbers encoded on them. The box is already -
filled out with the information on the selected label. If you only
want to print the selected label exactly as it appears, leave the
dialog box as it is.
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If you wish to print a series of labels with consecutive numbers
encoded on them, you must change the numbers in this dialog
box. For example, if you wanted to print labels with bar codes
representing the data 00001 through 00004, you would set the
First Bar Code Sequence number to 00001, and the Final Bar
Code Sequence number to 00004. This would produce labels with
the data values 00001, 00002, 00003, and 00004,

Click the Continue button to start printing. While printing is in
progress, a dialog box will appear offering you a Cancel button.
Use this button if you wish to cancel the printing operation before
it finishes.
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Appendix A: For Further Information

The publications listed below contain useful information on bar codes
and bar code standards.

For information on bar codes in industrial
applications:

“Uniform Symbol Descriptions USD-1 through USD-8"

“Scanning Products on the Move, Part 1, Moving Beam Scanner”
“Recommended Practices for Uniform Container Symbol (Printing Bar
Codes on Corrugated Containers)”

Available from:

Automatic Identification Manufacturers, Inc. (AIM)
An Affiliate of the Material Handling Institute, Inc.
1326 Freeport Road

Pittsburgh, PA 15238 .

Telephone (412) 782-1624

For information on grocery product distribution
container bar code standards:

“UPC Shipping Container Symbol Specification Manual”

“UPC Guideline #6 Shipping Container Coding (UPC Case Code)”
“UPC Guideline #12 Random Weight Shipping Container Coding (UPC
Case Code)” February, 1983

Available from:

Uniform Product Code Council, Inc.
7051 Corporate Way, Suite 201
Dayton, OH 45459-4294

Telephone (513) 435-3870

For information on Department of Defense
standards for Code 3 of 9 "LOGMARS”

MIL-STD-11894, “Standard Department of Defense Bar Code Symbology”
MIL-STD-129], “Marking for Shipment and Storage”

Awvailable from:

Naval Publications and Forms Center
5801 Tabor Ave

Philadelphia, PA 19120

Telephone (215) 697-3321
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For information on General Services
Administration Code 3 of 9:

MIL-STD-11894, “Standard Department of Defense Bar Code Symbology
FED-STD-123], “Marking for Shipment and Storage”

Available from:

General Services Administration
Specification Sales

Building 197

Washington Navy Yard
Washington, DC 20407

For information on bar codes in the automotive
industry:

“Bar Code Symbology Standard, AIAG-B-17
“Shipping/Parts ID Label Standard, AIAG-B-3”

Available from:

Automotive Industry Action Group
North Park Plaza Building, Suite 830
17117 W. Nine Mile Road
Southfield, MI 48075

Telephone (313) 569-6262

For information on bar codes in the heaith
industry:

“Health Industry Bar Code Standard”
Available from:

HIBC Council, Inc.

111 E. Wacker Drive, Suite 600
Chicago, L. 60601

Telephone (312) 644-6620

For Information on bar codes on transportation
packages:

“Specifications for Bar Coede Symbols on Transportation Package and Unit
Loads — ANSI MH10.8 x1983"

Available from:

American National Standards Institute
1430 Broadway

New York, NY 10018

Telephone (212) 354-3300
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Appendix B: Code 128 (USD-6)

VALUE CODE CODE CODE VALUE CODE CODE CODE

A B* C A B* C
000 SP Sp 00 037 E E 37
001 ! ! 01 038 F F 38
002 & “ 02 039 G G 39
003 # # 03 040 H H 40
004 $ $ 04 041 1 I 41
005 % % 05 042 ] ] 42
006 & & 06 043 K K 43
007 : ’ 07 044 L L 44
008 ( ( 08 045 M M 45
009 ) ) 09 046 N N 46
010 * * 10 047 e} o) 47
011 + + 11 048 P P 48
012 . . 12 049 Q Q 49
013 — —_ 13 050 13 R 50
014 . ) 14 051 S S 51
015 / / 15 052 T T 52
016 0 0 16 053 U U 53
017 1 1 17 054 v v 54
018 2 2 18 055 W W 55
019 3 3 19 056 X X 56
020 4 4 20 057 Y Y 57
021 5 5 21 058 Z Z 58
022 6 6 22 059 [ [ 59
023 7 7 23 060 y \ 60
024 8 8 24 061 ] ] 61
025 9 9 25 062 - . 62
026 : : 26 063 - _ 03
027 ; ; 27 064 NUL ’ 64
028 < < 28 065 SOH a 65
029 = = 29 066 STX b 66
030 > > 30 067 ETX ¢ 67
031 ? ? 31 068 EOT d 68
032 @ @ 32 069 ENQ e 69
033 A A 33 070 ACK f 70
034 B B 34 071 BEL g 71
035 C C 35 072 BS h 72
036 D D 36 073 HT i 73

*Mac-Barcede uses Code B by default.
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VALUE CODE CODE CODE VALUE CODE CODE CODE
A B* C A B* C

074 LF i 74 093 GS } 93
075 VT k 75 094 RS ~ 94
076 FF 1 76 095 us DEL 95
077 CR m 77 096 FNC3 FNC3 96
078 SO n 78 097 FNC2 FNC2 97
079 SI o 79 098 SHIFT SHIFT 98
i - - - ggg ggggg C%éEr;C 00%913 B
gg; géé ‘j :L 101  FENC4 CODEA CODE A
e pin . o 102 FNC1 FNC1 FNC1
084 DC4 t 84
085 NAK u 85 103 START (CODE A)
086 SYN v 86 104 START (CODE B)
087 ETB w 87 105 START (CODE C)
088 CAN X 88
089 EM y 89
090 SUB z 90
091 ESC { 91
092 FS | 92 STOP

*Mac-Barcode uses Code B by default.
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Index

Apple Menu, 17

Bar Code Data Window, 18-19

Bar Code Tool, 15

Bar Codes. See also Symbologies,

X-Dimension

changing height of, 36-37, 49
characters represented, 9
entering characters for, 19
industry standards, 9
interpretations of, 32-33
number of characters in, 9
orientation of, 32
position in labels, 42
ratio of bars and spaces in, 37
width of. See X-Dimension
with Easel Tool, 53

Bar Codes Menu, 17, 31

Bottom Justify, 42

Center Justify, 42
Change Bar Height, 36-37
Clear, 52
Clipboard, 51
Code 128, three-digit codes, 38,
61-62
Copy, 52
Create Compressed, 37
Create Preferred, 37
Cut, 52
with other programs, 53

Disks, backing up, 13
Display Horizontally (bar codes)
32

Display Horizontally (labels), 40
Display Interpretation, 32-33
Display Vertically (bar codes), 32
Display Vertically (labels), 40
Dragging, 25-26

interpretations, 33

text, 45-46
Drawings, 47-48
Duplicating objects, 52

Easel Tool, 16, 53
with bar codes, 53
Edit Menu, 17, 51

File Menu, 17, 27
Fonts Menu, 18, 44-45
Free Form, 42

Hand Tool, 16, 53-54

Hide Item Outlines, 49-50

Label Tool, 16
Labels
consecutive, 57-58
continuous form, 56-58
printing, 56-58
Specify Dimensions of, 40
Labels Menu, 18, 39
Left Justify, 42

Manufacturer’s Code, 34
Menus. See also specific menus
using, 17
Merge, 29-30
Moving
objects. See Dragging
work page, 53-54
Work Window, 53-54

New, 27
Number System, 34

Objects, 49
deleting. See Clear
duplicating, 52
moving. See Dragging
selecting. See Selecting
Open, 29

Paste, 52

with other programs, 53
Pen Tool, 16, 47-48
Preview Page, 53-54
Print Alignment Label, 56-57

INDEX &3
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Print Page, 55-56

Print Selected Label, 57-58

Printing, 24, 55-58
consecutive labels, 57-58
number of copies, 55, 56

Product Number, 34

Quiet zones, 8, 49-50

Quit, 30

Right Justify, 42
Save As, 29
Save, 28
Scanners, 7
and X-Dimension, 8-9
Scope, 15
Select X-Dimension, 35-36
Selecting, 49
objects, 25-26
text, 45-46
Show Item Outlines, 49-50
Specify Dimensions, 40-41
Specify Inter-Label Gap, 41
Starting Mac-Barcode, 13-14
Style Menu, 18, 44
Symbologies
how to choose, 9-12
selecting from menu, 54-35
supported by Mac-Barcode,
10-11
types of, 8

Text
editing, 44

64 INDEX

selecting and dragging, 45-46
Text Box, changing size of, 44
Text Tool, 16, 43
Tool Palette, 15
Top Justify, 42

Undo, 52
Universal Product Code (UPC)
and Display Interpretation, 33
characteristics of, 10-11
Caode A, 34
Code E, 34
dialog box, 34
displaying vertically, 32
Updates, inside front cover
User Support, inside front cover

Viewing Menu, 18, 55

Warranty, inside front cover
Work Window, 18

moving, 53-54
Work page

editing, 49-54

moving, 53-54

printing, 55-56

saving, 28

viewing, 53-54

X-Dimension, 8-9
and scanners, 8-9
setting, 35-36
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